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APPENDIX I 

LESSON PLANS PREPARED FOR CBAE 

Lesson I: Doodle to Drawing...through Digital Art 

Class:     Std. IX   Duration: 3 sessions (about 40 minutes per session) 

Introduction: Regardless of any advancement in technology, pen and paper will 

always be the number one choice for any budding artist or illustrator. It is with the 

pencil sketches that we create great designs. So, what exactly makes a doodle so 

fascinating even though it is claimed to be one of the most unproductive ways of 

spending time. Maybe a gross understatement, but once you look at these creative 

doodles, you will know what I’m talking about. Popular kinds of doodles include 

cartoon versions of teachers or companions in a school, famous TV or comic 

characters, invented fictional beings, landscapes, geometric shapes, textures, banners 

with legends, and animations made by drawing a scene sequence in various pages of a 

book or notebook. In this lesson, the teacher will show some of the doodle art done by 

the children. Also at the end of the lesson, the teacher will give links to some really 

useful resources and articles which can be interesting to the students.  

 

Before I start the exercise, it is better to make understand about the possibilities and 

functions of the software to be used. You may know about the software from the 

previous years. Doodles are simple drawings of just a few meaningless lines. You add 

your own lines - and colour if you like - to create a sketch of anything you like. The 

point of doodles is not to create art, simply to use your creative vision. 

 

1st Session: The teacher will show the students a Power Point of Jackson Pollock 

painting and will discuss where he painted and how he painted. How the strokes come 
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out nicely with a gentle force. The freedom of expression and the feeling can be 

enjoyed while doing this exercise. The intention of this is to inspire the students to 

reach over the rainbow and discover the joys of art and creativity.  

 

2nd Session: Through Internet - http://www.manetas.com/pollock/ the teacher will 

show the students the demonstration of Jackson Pollock painting. The strokes, colour, 

motion and formations are changes with movement according to the feelings. 

 

Software Used: Microsoft Paint  

 

Topic: Doodles of your feelings  

It is very simple drawings of just a few meaningless lines. You add your own lines - 

and colour of your likeness - to create a sketch of anything you like. The point of 

doodles is not to create art, simply to use your creative vision. 

 

Process: Students enjoy drawing and altering around on the computer, combine the 

two to experience digital doodling. By use a program Microsoft Paint, included with 

all Windows operating system installations, to draw directly on the screen. With the 

computer mouse and the software's tools and paints, they brought objects to life 

objects with a couple of quick strokes.  

 

Instruction: 

1. Open the "Paint" application, which defaults as a blank page of drawing space 

sized 8 inches wide by 6.4 inches high. To change the page size, click the 
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"Paint" button in the top left corner of the screen, click "Properties," type in 

the new dimensions and click "OK." The workspace automatically adjusts. 

2. Click the "Brushes" button and click the first option, "Brush." Click the "Size" 

button and click the first option that shows the thinnest line. 

3. Click a brown-coloured box from the "Colours" section, which puts that 

colour in the "Colour 1" box on the toolbar. 

4. Draw any shape, such as a rectangle, circle, rectangle or oval with different 

tools at the toolbar. 

5. Click the "Fill with Colour" tool, which looks like a tilting paint can on the 

"Tools" section of the toolbar. Click inside the tree trunk to fill it with the 

different colours. 

6. Click the "Brushes" button and select the "Watercolour brush." Click the 

"Size" button and select the second thinnest line. 

7. Switch back to the other paint colour and click the "Pencil" tool in the "Tools" 

section. Draw fine lines for giving a detailing on the painting. 

8. Change paint colours and brush heads to add some special effects, where ever 

needed. You can erase the unwanted area by taking the erase tool from the 

"Tools" section. 

9. Click the save button when the work of art is up to the satisfaction, than save it 

to a folder file. 
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3rd Session: Implementing the exercise with the software Microsoft Paint or Tux 

Paint. 

Software Used: Microsoft Paint  

Topic: Draw any portrait 

1. Open up the MS Paint program to start a new document. The program can be 

found in the Accessories menu on your computer. 

2. Click on the background and foreground boxes, and select the colours you 

want each to have. Using a white background and black foreground is the most 

common choice for drawing because you can colorize it later. 

3. Select the tool you want to use to draw a picture of a face. Using the pencil 

tool allows you to draw any type of shape you want while clicking on the 

buttons for ellipses or rectangles will make that shape appear on your screen. 

4. Draw the facial features or the depth with the pencil or brush tools. 

5. Make light glares in the eyes by using the eraser tool. Click on it, and then 

remove a small section of colour from inside the iris. 

6. Create hair by clicking the "Line" and "Curve" buttons. These tools draw lines 

wherever the cursor is placed. 

7. Scan your hand-drawn portrait and save it as a file on your computer. 

8. Open the MS Paint application in order to begin the colorization process. 

9. Open your scanned document within the MS Paint program. 

10. Select the colour that you want the foreground to be from the palette of 

colours shown. 

11. Use the paint-bucket tool to fill a large area with one colour. Click on the area 

to colour, and then select the paint bucket. Be sure to change the colour before 
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repeating the process, unless you want to use the same colour throughout your 

picture. 

12. Use the pencil tool to touch up lines that may have been lost when you 

scanned your artwork. 

13. Choose the paintbrush to paint small areas with irregular shapes or lines. 

14. Print out your edited face once you have finished colouring it. A hard copy 

may be easier to look at to notice mistakes or areas you would like to redo. 

15. Save your document once you have it the way you want it. 

 

Outcomes: 

• Students intentionally take advantage of the qualities and characteristics of art 

media, techniques, and processes to enhance communication of their experiences 

and ideas.  

• Students generalize about the effects of visual structures and functions and reflect 

upon these effects in their own work. 

• Students integrate visual, spatial, and temporal concepts with content to 

communicate intended meaning in their artworks. 

• Students compare multiple purposes for creating works of art. 

• Combine different techniques and tools in your drawing to add visual interest. 

•  Use the line tools to draw perfectly straight lines.  

• Compose with the shape tools by drawing triangles, circles and squares.  

• Overlap and intersect them to create abstract drawings.  

• Use the colour fill tool to add hues to your shapes or in the spaces between them.  

• Make use of the eraser tool when you make a mistake.  

• Paint over larger areas with white if you don't like them.  
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• Be creative and let the tools lead you into experimenting with lines, shapes and 

colours. 

• Print out and frame your best drawings or use them as backgrounds on your 

computer screen. 

 

Lesson II: Painting to Pop Art.......through Electronic Media 

Class:     Std. IX   Duration: 3 sessions (about 40 minutes per session) 

 

Introduction: All forms of art making can incorporate through digital media and 

at its simplest software can be used to follow traditional art concepts and techniques. 

For example, scanning simple objects or pictures (such as a person’s hand) provides 

something for a person to manipulate. Collage of multiple images is easily achieved 

through basic techniques such as copy and pasting, cropping, rotating, layering and 

use of filters. Adding text can take the student into message creation and 

manipulation. A simple line drawing, once scanned and manipulated can take on new 

meaning. Using a tablet and pen you can draw free-hand and can provide a familiar 

start to digital art practice. Colour can be quickly manipulated through colour sliders 

that illuminate fundamental colour theory without the need of a colour wheel.  

 

Digitising preliminary ideas, drawings and sketches or photographs of 3D work can 

enable us to manipulate initial ideas and to experiment with different design elements. 

By doing this we can explore a number of possible solutions. The technology is doing 

the labour and we are doing the thinking, making design decisions. Creating our own 

images and to avoid downloading pictures from the Internet is important as the 

pictures from the Internet are generally of a low resolution and will result in 
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low quality print reproduction. It is also important to take care about copyright issues 

in relation to the use and manipulation of images. 

 

This lesson is directed towards studying art style of pop art in today's new digital-

based classroom. This lesson is a great way to combine the old printing style into a 

new and easier way for you to understand. Pop art was a very unique artist movement 

and it is an art form that you would really be able to enjoy and understand. For this 

lesson, the students will take a picture of themselves using a digital camera, web cam, 

or scanner. With that they will upload them into a photo editing software program. 

 

1st Session:  

Topic: Concept of Colour  

It was usually thought that children are born colour blind and learn to distinguish 

colours over time. Recent researches have shown that it is not true, as babies as young 

as four months old have preferences of colours. That‘s why colours are even more 

important in a child‘s life, and in even younger age than thought before. 

 

If we believe researchers from Surrey Baby Lab, children distinguish colours right 

after they are born. They learn the names of the colours in ages 2 to 5, and the first 

names they learn are of the colours they like, which are bright and clear, like red, 

yellow or green. Red and yellow are thought to be the favourite colours of babies and 

children up to the age of 5. Since the age of 6, children usually learn more colours and 

their opinions toward them tend to become more individual and different from other 

children. This also helps children to express themselves. Colours can also teach 
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children a certain way of life. Colour is a powerful and important communication tool 

and it is attached to religious, cultural, political and social influences. 

 

The teacher will discuss about the Colour theory, different media and materials to 

create paintings with the help of power point presentation. The teacher will allow the 

students to have the freedom to paint without trying to make a picture and play with 

the essence of colour composition. 

 

2nd Session:  

Topic: Concept of Pop-Art  

What is an art movement? How can we distinguish one artist’s work from another? 

What does it mean to be popular? Do our opinions about what is popular change? 

How the works of artist Andy Warhol became popular in the society. Pop artist Andy 

Warhol made silk-screens of photos. He would paint directly on silk to create a 

unique image. To gain an understanding of this style, students will be viewed a 

number of Warhol samples. Students will notice of the characteristics common to all 

the paintings, such as: 

• unrealistic and bold colors 

• solid colors instead of shading 

• exaggerated makeup 

In the same way, students will use common objects from popular culture to transform 

their portrait into a billboard that expresses their personality. To prepare for the 

activity, students consider items from their favorite music, movies, cartoons, sports, 

hobbies, fashion, and games that they could use in artwork. Next, they create drawing 

or photographs and save images of these pop culture items. 
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This Pop art is also created by using a digital photo and photo editing instructions to 

select a section of the picture, such as a hat or hair and paste one of the saved pop 

culture images into the selection. By adjusting the transparency, a unique effect is 

created. The result is a picture with the entire body shape filled in with items that have 

personal meaning.  

 

Through a series of steps, the students will understand things like photo filters, 

cropping, and colour designs on the computer. From this lesson, students will come to 

know about the software programs and will create a fun pop art piece of artwork that 

can connect with their own identity.  

 

3rd Session:  

Software Used: befunky  

 

Topic: Pop Art - “Make your favourite 

photo” One of the most popular photo 

editors just got even better! BeFunky is the 

software that leaves all creative control with 

you while keeping everything super easy to 

use. 

Instruction: 

1. Go to the BeFunky Applications Page, 

upload any photo or image and apply 
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the desired effects. BeFunky lets you upload the photos from a large number of 

sources like your computers hard drive, picture taken from a webcam or from a 

social network like Facebook. 

2. Once you upload the photo, you can 

then choose the effects shown on the 

left sidebar and click on the effect to 

apply it on your uploaded image. 

3. Change the intensity of the effect you 

want to apply by adjusting various 

parameters provided. This way, you can 

experiment with the effect and adjust 

the final version to your liking. 

4. Use Editing options such as crop, rotate, 

brightness to fix your photos. 

5. Next, click Pop Art in the left margin. 

The menu expands, displaying different 

pop art effects. Select one to start the 

modifications to your photo. The 

BeFunky progress bar appears while 

your image is modified with the chosen style. It won’t take long. Soon your 

modified image will appear on screen. 

6. It has over 68 effects included: Vintage, Pop Art, Grunge, Viewfinder, DuoTone, 

Toy Camera, Sketch, Tilt Shift, Instant, Old Photo, Cross Process, Cyanotype, 

Gritty HDR, Pinhole, Orton, and many more. Now select the Pop Art option. 
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7. You have created a pop art masterpiece! But don’t stop there. You will want to 

experiment! Click Settings in the tools menu to open the Settings pop-up. Each 

pop-art effect has a different combination of settings for you to experiment with. 

Most are changed with a slider control. 

• Changing Sketch Detail, Detail Level, and Silhouette Amount modifies 

details and contrast. 

• Colors can be modified by changing Brightness, Color Space or Color Value 

settings. 

• You can vary the intensity of the newsprint quality with the Halftone Size 

control. 

8. Experiment with the available settings to discover how they alter your image. 

You can always return to the original settings by clicking Reset. 

9. When you are happy with the results, use the buttons at the top right menu 

to save, share or print your new creation. 

 

In the end the students will print out their images in poster form. The students will 

cherish that poster as well as will remember the style behind it as they will create the 

design themselves.  
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Lesson III: Sketching to Still Life.......through Electronic Media 

Class:     Std. IX  Duration: 3 sessions (about 40 minutes per session) 

 

Introduction: To become an artist, we really have to go out into the world and learn 

to sketch virtually everything we see, from people, pets, houses, cars, trees, flowers, 

mountains, waves, clouds, etc.. Just remember that a computer and tablet will not 

make a good sketch artist. We have to be a good artist if we develop our observational 

quality.  Sure, I was recommend many hours and years of practice with paper and 

pencil, but, there is no reason a person can't learn the craft by starting on a computer. 

Good results come from the artist's talent and experience, not from the tools.  

 

Recently, the art students were given to work with all the traditional tools from paper, 

pencils, pens, charcoal, pastels, oil pastels, markers, clay, plaster, wood, stone, 

canvas, watercolours and so on. But now-a-days, with the help of computers are 

useful in place of these traditional tools.  

 

Sketching skills can pretty much be split into two categories: traditional skills and 

digital skills. Traditional skills would obviously be pencil, paper, and marker 

sketching. Digital skills would include using software like MS paint, Inkscape, 

Sketchbook Pro, Photoshop and the like to sketch. The differences in the uses of these 

two categories are skills, knowledge, experience and practice. Each one is more 

important than the other. We will learn about the characteristics of both categories and 

will compare them for different situations.  
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1st Session:  

Topic: About Traditional Sketching and Digital Sketching 

 

Traditional Sketching 

Traditional sketching skills are usually the first thing fresh young designers learn 

when they begin their studies. Starting from basic shapes and advancing to more 

advanced forms, they learn to use the pen to quickly express their design intent. 

Traditional sketching is an important skill for any designer. You don’t have to be 

amazing at it, but you do have to be able to communicate through drawing. I think 

that hand sketching is best suited to the early stages of the design process. It allows 

you to quickly get your ideas down, and just think through and externalize all your 

ideas with your hands. Being able to spread out all your sketches and ideas on paper 

can really help you make design decisions. You can only have one computer screen, 

but you can have as many pieces of paper in front of you as you want. Personally, I 

always start my ideation by hand, and perhaps move to digital sketching later to refine 

my ideas. 

 

Pros: 

• Its fast: you should be able to draw with pen and paper much faster than you 

would with a computer. 

• It’s relatively cheap: there is no prohibitive startup cost of equipment here, just 

pen and paper. Markers may get kind of expensive, but nothing compared to 

buying a good drawing tablet. 
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• It’s impressive: hand sketching is definitely a skill that impresses people. 

People like to see that you can communicate clearly and with flair with pen 

and paper. 

• It’s handy: you will be able to jot down a quick sketch, or explain something 

to someone through drawing just about anywhere, as long as you can find a 

pen and a surface to draw on. 

 

Cons: 

• It can get messy: when you start sketching on a piece of paper without a clear 

idea of how you will layout your sketches, it can get quite crowded and messy, 

making it hard to distinguish individual ideas. 

• There is no undo: one mistake and you will either have to live with it or start 

over. 

 

Digital Sketching 

Digital sketching skills are becoming very important to designers as well. Using a 

drawing tablet and software, you can create exciting and colorful sketches and 

renderings that benefit from the power of undo and other computer trickery such as 

resizing and re-colouring. Digital sketching is useful for creating nice presentation 

sketches. Using a computer means that the sketch can be very clean and polished to a 

shine. Of course digital sketching can be used for quick doodling and roughing out 

ideas as well, but usually this is not my preference since hand sketching is still faster 

for me. Usually I bring in digital sketching to refine my initial concepts... 
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Pros: 

• It’s clean: with undo and multiple layers, it is possible to create very clean yet 

exciting sketches, though they may take considerably more time to achieve. 

• It’s visually exciting: with all the different tools offered by various software, 

digital sketches can often be much more visually crazy than hand sketches. 

• The freedom of undo: knowing that you can easily erase or undo any mistakes 

gives you much more freedom to try drawing something crazy or experiment 

with new techniques. 

• Easy to store and share: you can easily have all the digital sketches you have 

ever done right on your laptop and you can share digital sketches with clients 

and colleagues without the hassles of scanning 

• Simple variations: with digital sketches, you can change any number of simple 

things like color, contrast, etc. with a few clicks and save a variation easily 

 

Cons: 

• Its slower: digital sketching is usually not as fast as quick hand sketching 

• It’s expensive: to do digital sketching effectively, you’ll need a drawing tablet, 

which can cost you. Software is also expensive.  

• It can be too flexible: being able to change everything as you go can make you 

very indecisive about design details. Also unless you save every single 

version, you may not record as many as your variations as you may later like. 

In hand sketching, once you’ve drawn it, it is there for later reference. 

 

However, I have to say that traditional sketching is still the more important skill as it 

forms the basis for digital sketching. You should be confident in your pen and paper 
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sketching before trying to move into digital sketching. Once you are good enough and 

hand sketching, try to apply your skills to the computer. Don’t be afraid to experiment 

and try new techniques, as there is always the undo button. With enough practice, 

your digital sketching will be as confident as your hand sketching. In this Package, I 

have showcased some of observational drawing, the concept of sketching and the 

fundamentals of composition, line, shape, and form.  

 

2nd Session: 

Software Used: Microsoft Paint, A camera or scanner  

Topic: Still Life Study  

 

The teacher will make the students understand how to observe and draw plants in 

containers in the classroom. How to illustrate the object as you see it - form, shape, 

colour, tonal range, texture, composition, cropped or fully conveyed, negative & 

positive space, contour line, etc. Some examples also will be looked at and will be 

discussed. Students will pay attention to placement on the page, details and patterns.  

  

Process: 

Before the teacher start the exercise, he will make the students understand about the 

understanding the tools  

• Pencil tool: This tool works like a traditional pencil except that it can only 

create hard-edged lines. The thickness of the line can be adjusted in the 

Brushes palette. 

• Paintbrush tool: Paint or colour is applied in even strokes on the canvas with 

this tool. The brushstroke size can be adjusted in the Brushes palette. Once 
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selected, your cursor will become a circle that shows the actual size of your 

brush. 

• Paint Bucket/Fill tool: This tool fills selected objects or an entire image with 

a selected colour. 

• Airbrush tool: It applies paint with diffused edges. Different brush sizes and 

shapes and varying amounts of pressure can be adjusted in the Brushes 

palette. 

• Eraser tool: Use this tool to rid the canvas of unwanted elements. 

 

3rd Session: 

Instruction: 

1. Organize a still-life setup or arrangement that symbolizes you or your interests. 

2. In your sketchbook, create a clean, crisp modified contour line drawing of your 

still life. Do not add value or colour.  

3. Place your final sketchbook drawing facedown on the scanner and scan the 

image. Follow the instructions provided with your scanner. Set the scanner to 

scan the image at 100 percent at 300 dpi (dots per inch) and save the scanned 

image as a TIFF file. Save this image to a storage device (Zip disk or CD) so 

that it can be transferred to your computer if necessary. 

4. Open the image in a paint program and save it again with a new name. Then 

save once again with the same new name and a number one (1) next to the title. 

This second saved file allows you to keep the original scan intact without any 

modifications. 

5. On this last saved copy, trace over your pencil marks using the Pencil tool on 

the toolbar. 
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6. Experiment with the tools listed in Understanding the Tools above to suggest 

the form for each of the items in the still-life arrangement. Add colours, value, 

and details. 

7. Look carefully to observe the lightness and darkness of each object. Select light, 

middle and dark values of the colours for each item in the arrangement. 

8. Colour your arrangement with realistic colour. This allows you to copy the 

colours that you observe. For example, if the apple is red in the still life, your 

painted apple should be red. 

9. Save your final work and print. 
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Lesson IV: Poster to Publicity.......through Digital Media 

Class:     Std. IX  Duration: 3 sessions (about 40 minutes per session) 

 

Introduction: The tools and techniques available for visual arts expression have 

expanded tremendously with the creation of new hardware and software provides 

unique opportunities to extend visual arts learning. Society now demands new visual 

literacy for its citizens to function effectively in social and employment contexts. 

Furthermore, the very nature and interests of students themselves contribute to the 

changing face of visual arts education. Electronic media can engage and inspire 

teachers and students alike. Developing ways to incorporate electronic media in 

the curriculum may require a shift in thinking from trying to simply imitate what we 

already do such as painting, drawing and art theory to engaging in modes of delivery 

that are exciting to a multi-literate class. Electronic media should compliment 

traditional approaches in the art classroom helping to inspire students, develop their 

conceptual thinking as well as their creative skills. The teacher will present a range of 

resources and ideas which highlight the breadth of potential for electronic media in 

the secondary visual arts classroom and will also explore how you can use technology 

in broad ways: 

• To support art research and documentation 

• To engage students in interactive learning 

• To develop creativity through art making 

• To foster collaboration, communication and exhibition and 

• To encourage cultural exchange, understanding, awareness and appreciation 
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1st Session:  

Topic: Make a Poster on Social Campaign 

 

Identify the social issues or environmental challenges that are most “relevant, 

meaningful, and actionable”. This brainstorming activity is meant to provide a path 

for individual or a group of students to discover and decide collaboratively which 

issues want to consider, without necessarily determining a solution. Team's Social 

Action Project should be a step-by-step strategy for addressing a social problem, need 

or challenge in our community or around the world.  The action plan will include the 

positive social change you wish to create and include those who will benefit from 

your Social Action Project.  Great Projects begin with planning for the end result. 

There are four major parts: Problem, Solution, Impact, and sharing  

To do this, you or your Team members will 

1. Select and research a problem or challenge you want to address 

2. Identify, refine, and implement a solution.  

3. Measure and record the outcome or impact in the community. 

4. Share the Story of Social Impact with the global community on the 

Foundation Showcase 

 

Some of the Social Issues can be highlighted during the discussion. 

Health Related:  

Smoking, Obesity, Nutrition, Autism, Cancer, AIDS, Diabetes, Operation Smile, 

Doctors without Borders, Red Cross 
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Community Issues:  

Drug Abuse, Cyber-bulling, Suicide, Parenting, Crime, Rape, Abuse, Literacy, 

Poverty, Cleanliness, Pollution, Safety, 

Human Rights:  

Gun Violence, Missing Children, Human Rights, Advocacy, Children’s Rights, Right 

to Education, Literacy and Right to Information. 

Global Issues:  

War, Oil Dependence, Energy Conservation, Pollution, Child Labor, Carbon 

Emissions, World Hunger, Accuracy in Media, Freedom of Speech, Global Warming  

Environmental:  

Oceans, Rainforests, Preservation, Forest Fires, Environmental Defence, Greenpeace, 

Wildlife Conservation, Global Warming  

Animal Related:  

Abuse, Cruelty, Vegetarianism, Milk, Factory Farms, Wildlife, Endangered Species 

 

2nd Session: 

Software Used: Microsoft Power Point 

Topic: Social Campaign 

1. Open Microsoft PowerPoint 

• Children have taken to the 

PowerPoint Workspace 
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2. Setting the Size and Orientation of your Poster 

The most common size of poster is A4 (21.0 x 29.7cm,   8.27 x 11.69 inches), the 

maximum poster width and height that PowerPoint will allow is 140cms or 56 ins.  

To change the size and orientation 

• Click the Design tab on the ribbon      

 

 

• Click Page Setup 

 

• A dialog box will appear:  

 

 

 

 

• In the ‘Slides sized for:’ drop down menu, select ‘Custom’ 

• Type 21.0 in the width box and 29.7cm in the height box for an A4 Portrait 

poster. 

• If your poster requirement is for a 

portrait style poster (tall and thin), 

then click the portrait orientation 

button to swap the values around 

for a portrait layout. 

• Click OK to see your new A4 

slide. Your workspace should now 

look similar to the picture below. 
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3. Display a Grid 

When we come to introduce the different 

elements to our poster, it is beneficial to use a 

grid and to help us align our images and text. 

Turn on the Grid 

• Right click on any blank part of the slide  

and left click Grid and Guides.... 

• In the Grid and Guides dialog box, leave 

the spacing as is and put a tick in all the 

boxes except the one named ‘Display 

drawing guides on screen’. 

• Click OK 

4. You should see the grid overlay on the 

workspace 

 

5. Apply a Background to your poster 

To access the options for changing the 

background, 

• Right click on the slide and left click 

‘Format Background...’  

This dialog box contains three main options 

• Solid fill : Applies a wash of a single 

colour across the background 
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• Gradient fill : Applies a blend of two or more colours gradually across the 

background 

• Picture or Texture fill : Applies a large single picture background or a regular 

tiled picture background 

We do not recommend using the transparency function to lighten the background 

image of a poster as this has proved to print unpredictable results 

6. Examples of each are shown below (without the grid showing for clarity) 

 

Add Text to your Poster 

• Click the Insert tab  
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Click on Text Box                 

 

 

• The cursor will change shape to that of 

      a long cross 

 

• Left click anywhere on the slide to place 

the text box.  

• Click the bottom right hand circle on the 

text box, old, and drag it to the right to 

make it larger. 

• Click inside the text box to start typing.        

• You can also copy and paste text into the 

text box from other packages. 

• To rotate the text box click and drag the  

green control circle at the top of the box in 

a circular motion. 

 

 

 

7. To change the font, colour, and size of 

the text in the text box, highlight the text: 

• Click on the Home tab 

• All the options are under the Font section on the ribbon. 
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8. Add a WordArt Title 

• Click the Insert tab and click WordArt   

 

 

You will be presented with a list of text styles of 

different colours and shadows. 

 

 

 

 

• Select anyone of these letter ‘A’s and left 

click anywhere on the slide 

You should see something that looks like this: 

 

 

If you decide that you would like to change the colours or style of the word art later, 

• Click on the text. 

• Another option called Drawing Tools will 

appear on the ribbon: 

Clicking on the Format tab will open all the drawing 

tools on the ribbon. To alter the WordArt text we need 

to a use the section marked ‘WordArt Styles.’ 
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Clicking on the letter ‘A’s in this box will automatically alter the text 

9. Add a picture 

There are two ways to add pictures to a PowerPoint slide. 

You can either drag an image from the desktop or 

You can use the Insert Picture function. 

To insert a picture: 

• Click the Insert tab 

• Click Picture 

• This will open a browser window to ‘Pictures’. You can however, navigate to 

other folders from here. 

• Select the picture file that you want to use and click insert. 

• Resize the picture using the controls on each corner and edge of the box 

surrounding the picture. 

• You can rotate the picture by clicking and holding the green control at the top 

of the picture and dragging around it. 

 

10. Save your final work and print. Ready to display or post it to other social 

media, school websites, digital library, competitions etc. 
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3rd Session: 

Software Used: Websites & Different Social Media 

Topic: Awareness Campaign 

Social Campaign: School publicity, Social media and Communications 

• Using School Display Board 

• Using School Website 

• Using School News Letter 

• Using Email to friends and other schools 

• Using Facebook 

• Using Twitter 

• Using WhatsApp 

Facebook is the most popular social networking tool in the world. By using such a 

widely known tool you can bring school news, updates and celebrations to a large 

audience and enable them to interact with the school Facebook page. Facebook pages 

can be an effective means of communication, there are some risks associated, 

including the potential for inappropriate or offensive comments to be posted by 

others. It is essential therefore that the service is well managed and that someone has 

the responsibility for monitoring the use of the page and responding rapidly to 

inappropriate use if necessary. 
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Lesson V: Creation to Composition.......through Electronic Media 

Class:     Std. IX  Duration: 3 sessions (about 40 minutes per session) 

 

Introduction: Art creations are messy. The process of creating art is that young 

children learn from, not the end product. When they create, experiment and 

discovered things they enjoyed. The importance of exposing kids to art early in life is 

often undervalued. But giving young children an appreciation for art encourages 

exploration, self expression, logical thinking, self-esteem, imagination, and creativity. 

Early art experiences also teach kids to think openly, create new meaning, be more 

tolerant of others’ differences and gives them the courage to take risks. Showing 

pictures can interpret stories, convey meaning, communicate ideas, and express 

emotion without the use of words.  

 

Composition whether used in music or visual arts always refers to the conscious act of 

putting things together. Many artists, designers and other art professionals use the 

word "composition" interchangeably with "visual ordering," "form," "formal 

structure" or "design." 

 

If we ask to a person to do whatever he/she want to do then the person will often 

avoid risk by doing something already he/she has learned in the past.  The amount of 

creative thinking may be zero.  When there are limits, there is a better chance of 

having a challenging task.   

 

The challenge in creative problem solving is to make the limits seem convincing and 

interesting to the student.  By asking questions, providing learning goals, reasonable 
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objectives have made the children to imagine in an easier direction. As a teacher, my 

job is to make the easy challenging and to make the hard stuff accessible. If the 

thought process is clear then the work of art or to create a composition in any medium 

became easy. Only the understanding of the material and application of uses needs to 

be handled carefully. 

 

1st Session:  

Topic: The Principles of Art 

The teacher will show a power point presentation; about the eight principles of art are 

balance, proportion, unity, harmony, variety, emphasis, rhythm and movement.  All of 

these principles clearly deal with the placement of elements within any work of art. 

So, the principles of art typically deal with composition. The teacher will also suggest 

that there are eight concrete principles of art and few others that would be considered 

art fundamentals.   

 

Composition in art is the overall collection of elements, objects, tone, mood, setting, 

and other factors that come together to convey the idea. Composition is the term used 

for the arrangements of the elements in or the subject matter of a work of art.  

 

Then the teacher will exclusively use the computer for initial idea to create a 

composition. Its versatility is unbounded and more importantly the ability to revert to 

earlier versions is a time-saver. The most advantage after creating the composition is 

easy to visualize with the material, surface, texture, colour, volume, space, 

surrounding, lighting etc.. The possibilities are more to lead the thinking process. But 

it needs the good skill of traditional process as well as the software knowledge. For 
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any composition, basic layout or drawing 

is essential for any work of art. Now days 

it is mostly used for architectural design. 

It is also covered the other area like 

product design, fashion design, sculptural 

layout, installation, digital art, graphics, 

video installation, digital photography, 

illustration etc. 

http://www.slideshare.net/kpikuet/elements-and-principles-of-art-presentation 

http://makingamark.squidoo.com/composition-resources#module7033236 

 

2nd Session: 

Software Used: Adobe Photoshop 

Topic: Fantasy  

Children has to create a composition relate 

to there fantasy. 

1. Create a new document with 1024 

px height and 786 px width. Select 

preset “Foreground to Background” 

and fill canvas with a linear 

gradient. 

2. Open file “Sky so blue”, copy all 

and paste it into our document. 

Make sure layer is on top of all 

other layers. Double-click layer 
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thumbnail to enter advanced 

blending mode. Drag the upper 

sliders to the left until the dark 

blues disappear. 

3. Create new layer (Shift+Ctrl+N). 

Make sure layer is on top of all 

other layers. Select Brush Tool. 

Load Stars and Bubbles Brushes by 

going to Load Brushes inside 

Brush Type Selection. Paint with 

stars brush some stars with 

different sizes. 

4. Add a Hue/Adjustment layer 

(Layer > New Adjustment Layer > 

Hue/Adjustment) and use the 

settings below. Select Gradient 

Tool, black as foreground color and 

white as background color and 

apply on layer mask to make sure 

only the upper part is visible. 
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5. Open file “Full Moon”. Select 

Moon with Elliptical Marquee Tool 

or other selection Tool. Go to 

Select > Modify > Feather and 

place 20px. Copy selection and 

paste it on our document. Make 

sure layer is on top of all other 

layers. Update layer mode to Hard 

Light. 

6. Open file “The Earth seen from 

Apollo”. Select Earth. Copy and 

paste it into our document. Make 

sure layer is on top of all other 

layers. Apply following effects by 

going to Layer > Layer Style > 

Blending Options: 
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7. Open file “Old Windmill” and 

make a selection of the Windmill. 

Copy and paste it into our 

document. Make sure layer is on 

top of all other layers. Apply Edit 

> Free Transform and Edit > 

Transform > Warp to make 

Windmill fit the Earth. Add a layer mask (Layer > Layer Mask > Reveal All) 

and with Polygonal Lasso Tool mask away the unwanted parts. 

 

8. Create a new layer on top. Select 

Brush Tool and with a black soft 

brush at 50% opacity paint the 

Windmill’s shadow. Move this 

layer below the Windmill layer 

and clip it on Earth layer (Layer > 

Create Clipping Mask). Update 

layer blending mode to multiply. 

 

Outcomes: 

This particular study evolved from the photos and ideas left over from the drawing. 

First work began with a rough idea and few even rougher sketches of the various 

elements... 
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Another step was to convert the images into line drawings. They can be quite rough at 

this stage - there's no need for accuracy. And nor do the line-drawings need to be 

copies of your photos - use your photos for reference and draw whatever you wish or 

just sketch from life or memory - this system will seamlessly blend images from many 

sources.  

 

The rough line drawing of each element is scanned into Adobe and the resulting files 

left open so each can be dragged and dropped into the new composition file when 

required. Each element as it is dropped is automatically allotted its own layer. The use 

of layers will be described in detail and allows each to be moved, resized or switched 

on or off independently of the other elements. 

 

You can drag layers further down the hierarchy or drag them to the top. Selected 

layers can be merged into a single layer. And you can, of course, move each element 

around the setting and even move it back and forwards by altering its size. 
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